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Dynamic Simulations

Model Simulation brings your behavioral models to life with
instant, real-time behavioral model execution. Coupled with
tools to manage triggers, events, guards, effects, breakpoints
and Simulation variables, plus the ability to visually track
execution at run-time, the Simulator is a powerful means of
'watching the wheels turn' and verifying the correctness of
your behavioral models. With Simulation you can explore
and test the dynamic behavior of models. In the Corporate,
Unified and Ultimate Editions, you can also use JavaScript
as a run-time execution language for evaluating guards,
effects and other scriptable items of behavior.

Extensive support for triggers, trigger sets, nested states,
concurrency, dynamic effects and other advanced
Simulation capabilities, provides a remarkable environment
in which to build interactive and working models that help
explore, test and visually trace complex business, software
and system behavior. With JavaScript enabled, it is also
possible to create embedded COM objects that will do the
work of evaluating guards and executing effects - allowing
the Simulation to be tied into a much larger set of dependent
processes. For example, a COM object evaluating a guard
condition on a State Transition might query a locally
running process, read and use a set of test data, or even
connect to an SOA web service to obtain some current
information.

As Enterprise Architect uses a dynamic, script driven
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Simulation mechanism that analyzes and works with UML
constructs directly, there is no need to generate intermediary
code or compile simulation 'executables' before running a
Simulation. This results in a very rapid and dynamic
Simulation environment in which changes can be made and
tested quickly. It is even possible to update Simulation
variables in real time using the Simulation Console
window. This is useful for testing alternative branches and
conditions 'on the fly', either at a set Simulation break point
or when the Simulation reaches a point of stability (for
example, when the Simulation is 'blocked").

In the Professional Edition of Enterprise Architect, you can
manually walk through Simulations - although no JavaScript
will execute - so all choices are manual decisions. This 1s
useful for testing the flow of a behavioral model and
highlighting possible choices and processing paths. In the
Corporate, Unified and Ultimate Editions it is possible to:

. Dynamically execute your behavioral models
. Assess guards and effects written in standard JavaScript
. Define and fire triggers into running Simulations

. Define and use sets of triggers to simulate different event
sequences

. Auto-fire trigger sets to simulate complex event histories
without user intervention

. Update Simulation variables 'on the fly' to change how
Simulations proceed

. Create and call COM objects during a Simulation to
extend the Simulation's reach and input/output
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possibilities
. Inspect Simulation variables at run time

. Set a script 'prologue' for defining variables, constants and
functions prior to execution

. Use multiple Analyzer Scripts with differing 'prologues'
for running the Simulation under a wide range of
conditions

In the Unified and Ultimate Editions it is also possible to
simulate BPMN models.

Using the Model Simulator, you can simulate the execution
of conceptual model designs containing behavior. When you
start a Simulation, the current model Package is analyzed
and a dynamic Simulation process is triggered to execute the
model.

To get up and running with Simulation, the only steps
required are:

. Build a behavioral diagram (State or Activity for manual
or dynamic execution, Sequence for manual interaction
only)

. Optional: load the 'Simulation Workspace' layout - a fast
way of bringing up all the frequently used Simulation
windows

. Click on the Simulator Play button

If the diagram contains any external elements (those not in
the same Package as the diagram) you will have to create an
Import connector from the diagram's Package to the Package
containing the external elements. To do this, drag both
Packages from the Browser window onto a diagram and
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then use the Quick Linker arrow to create the connector
between them.

Simulation Overview

Aspect

Overview of the Model Simulator

Use of the Simulation Window and Related Windows,
and Running a Simulation

Set Up a Simulation and Activate a Simulation Script
Set Up and Use Simulation Breakpoints

Simulate the Use of Objects

The Use of Different Types of Action in Simulation
Perform Dynamic Simulation with JavaScript

The Use of Guards and Effects in Simulations

The Use of Triggers in Simulations

Call Behaviors and Variables
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Simulating Activity Returns

Simulating Structured Activity Behavior
Simulating Multi-Threaded Processes
Simulating Sub-Processes in Separate Diagrams
Performing BPMN Simulations

Simulate Win32 Dialog Behavior

Platforms and Available Editions

Platform/Edit Details
ion

Models and The Model Simulator currently supports
Platforms the execution of UML Activity,
Supported Interaction and StateMachine models and
BPMN Business Processes on the
Simulation platforms:
. UML Basic

. BPMN
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Edition Model Simulation is available at different
Support levels across the range of editions of
Enterprise Architect:

. Professional - Manual Simulation only

. Corporate and above - Adds dynamic
JavaScript evaluation; currently
JavaScript is enabled for
StateMachines and Activity graphs; it
is not enabled for Interaction diagrams

. Unified and Ultimate - Adds BPMN
Simulation
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How it Looks

Enterprise Architect has a special way of displaying model
information during Simulation. This helps focus attention on
the executing or active nodes.

During a Simulation, Enterprise Architect will dynamically
track and highlight the active nodes within your model. If a
node in another diagram is activated, that diagram will be
automatically loaded and the current node highlighted. It 1s
possible to modify the diagram while the Simulation is
running; however, the changes made are not recognized
until the current Simulation is ended and a new one begun.

Highlighting of the Active Node(s) During
Simulation

In this example, the currently active node (VehiclesGreen)
is highlighted in normal Enterprise Architect colors, and all
possible transitions out of the current node are rendered at
full strength.

The elements that are possible targets of the current active
node's outgoing transitions are rendered in a semi-faded
style so that they are readable and clearly different to the
other elements within the diagram. All other elements are
rendered in a fully faded style to show they are not targets of
the next Simulation step. As the Simulation progresses
(especially if automatically run), this highlighting helps
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focus the attention on the current item and its visual context.
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Simulation Windows

When executing a Simulation in Enterprise Architect it 1s
possible to set break-points, fire triggers, examine variables,
record a trace of execution, set Simulation speed, view the
Call Stack and visually trace the active nodes as the
Simulation proceeds.

When a Simulation runs, some aspects such as the output
and console input are found in the Simulation window
itself, while other aspects such as the local variables and
Call Stack use the standard Execution Analyzer windows.
The topic provides an overview of the main windows used
during Simulation.

Access
Ribbon Simulate > Dynamic Simulation >
Simulator > Open Simulation Window
Windows
Window Purpose
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Execution The Simulation window provides the

and Console | main interface for starting, stopping and
stepping through your Simulation. During
execution it displays output relating to the
currently executing step and other
important information. See the Run
Model Simulation topic for more
information on the toolbar commands.

Note the text entry box just underneath
the toolbar. This is the Console input area
- here you can type simple JavaScript
commands such as: this.count = 4; to
dynamically change a simulation variable
named 'count' to 4. In this way you can
dynamically influence simulation at
run-time.

Simulation o x

s

oo O | | Interpreted - | Tools - |30

[02434152] Configuration: mode: Interpreted simulation, platform: UML Basic
[02434153] Preparing Simulation Data
[024421028] Loading Machine
[024432093]  Simulation Started
[02443212] Process Order
{ [02443738] Process Order.ActivityInitial
[02444264] Process Order.Receive Order
[02444737] Process Order.Decision

1 4

Breakpoints  The Simulation process also makes use of

& Events the 'Simulation Breakpoints' tab of the

Window Breakpoints & Markers window
('Simulate > Dynamic Simulation >
Breakpoints'). Here you set execution

(c) Sparx Systems 2021 Page 14 of 148



Dynamic Simulations 2 September, 2021

breakpoints on specific elements and
messages in a Simulation. See the
Simulation Breakpoints topic for more

details.
Breakpoints & Events x
Al <y J @ | BreakpointSet T Eaa@
Enabled Mame
i Setup
= ehiclesGreen
4 I [
H 4 F M Debug Breakpoints Simulation Breakpoints

Simulation The Simulation Events window
Events ('Simulate > Dynamic Simulation >
Window Events') provides tools to manage and

execute triggers. Triggers are used to
control the execution of StateMachine

o .
transitions.
Simulation Events x
<no event set> MPSEN T YA AN ) =
Sequence Trigger Status Type Parameters Event Time Waiting Triggers
= PlayList not signalled  Signal MName PlayList =~ [@PowerOn
= PlaySong notsignalled  Signal Mame PlaySong
= PowerOn not signalled  Signal PowerOn
= PowerOff not signalled  Signal PowerQff
= SetRepeat notsignalled  Signal SetRepeat
= Stop not signalled  Signal Stop
I

Call Stack During the Simulation the Call Stack

Window window ('Simulate > Dynamic
Simulation > Call Stack') displays
information about the threads and current
execution context of the Simulation.

The Simulator supports multi-threaded
Simulations and will include a thread

c) Sparx Systems age 150
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entry for every active and paused thread
of execution. For each thread, the Call
Stack window will show the start or entry
context (such as a StateMachine element)
plus the current active element within that
thread. If the current active element is the
entry point of a composite Activity or
SubMachine state, the Stack will also
include the current active element within
that sub-context (and all further nested,
active composite, sub-states as well).

Call 5tack b

H B Gy NC)

o [0]

Pedestrian Crossing
gr Setup

Simulation The Simulator uses the standard Locals
Local window ('Simulate > Dynamic
Variable Simulation > Local Variables') to show
Window all current simulation variables when the

simulation is single stepping or paused at
a break point. Note that it 1s possible to
dynamically update these variables using
the Simulator Console.
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Locals x
Variable Value Type Address
§ looped 1
= & this
& countEarly 0
& countlate 0O
@ pedestriam  False
a4 I I
Recording During execution of your simulation, a

recording 1s kept of all activity and
displayed in the Record & Analyze
window ('Execute > Tools > Recorder >
Open Recorder'). This 1s similar to how
the normal call recording works in the
Visual Execution Analyzer.

Record & Analyze

PR =I=E=C)

Sequence

00000001
00000002
= 00000003
00000005
00000007
00000009
00000011
4

Instance  Method

Pedestrian Crossing

Pedestrian Crossing

Pedestrian Crossing

Pedestrian Crossing

Pedestrian Crossing

Pedestrian Crossing
Ll

Direction

Call
Call
Call
Call
Call
Call
Call

Method

Pedestrian Crossing
Pedestrian Crossing. Setup
Setup

VehiclesGreen
VehiclesYellow
Pedestrians Walk
Pedestrians Flash

Instance  Depth *

21
21
21
21
21 ¥
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Set Up Simulation Script

You can use Simulation Scripts to provide fine control over
how a Simulation starts. In general, you do not need to set
up a Simulation Script unless:

. You want to run an interpreted Simulation that requires
variables to be initialized before the Simulation
commences; this 1s useful for setting up global variables
and defining functions

« (In the Corporate Edition and above) You do not want to
apply the default behavior of interpreting the Guards (that
is, you prefer to use a manual execution), or

- You want to have multiple ways of running the same
diagram

For most diagrams it is possible to initialize a script for a

Simulation simply by setting variables in the first element or

connector after the Start element. For State Charts, this is

the Transit connector exiting the initial element, and for

Activity models this is the first Action element.

As an alternative, you can use Simulation Scripts to
initialize settings before a Simulation starts. This 1s useful
for setting up different sets of initial values using multiple
Analyzer Scripts, so that you can run your Simulation under
a range of pre-set conditions.

To configure a Simulation Script, first select the Package in
the Browser window, Package Browser, Diagram List or
Model Search. You can then use the Execution Analyzer
window to add a new script for that selected Package. You
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will use the 'Simulation' page of the 'Execution Analyzer'
dialog to configure the relevant properties.

Access

Show the Execution Analyzer window using one of the
methods outlined here.

On the Execution Analyzer window, either:

. Locate and double-click on the required script and select
the 'Simulation' page or

. Click on & - in the window Toolbar and select the
'Simulation' page

Ribbon Develop > Preferences > Analyzer > Edit
Analyzer Scripts

Execute > Tools > Analyzer

Context Browser window | Right-click on
Menu Package | Execution Analyzer

Keyboard Shift+F12
Shortcuts

Configure a Simulation Script
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Platform

Entry Point

Evaluate
Guards and
Effects using
JavaScript

(c) Sparx Systems 2021
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Action

For UML Activity, Interaction or
StateMachine simulation, click on the
drop-down arrow and select 'UML
Basic'.

For BPMN diagrams, click on the
drop-down arrow and select ' BPMN'.

Click on the [--] button and select the:
. Entry point for the Simulation, and

. Activity, Interaction or StateMachine
to simulate

If you do not specify an entry point, the
Simulator attempts to work through the
entire Package.

(In Corporate and higher editions) Leave
the checkbox unselected to perform a
manual Simulation, where you select the
next State to transition to and the point
where a decision must be made.

Select the checkbox to execute the code
for Effect behavior in the Stmulation. The
Simulation executes JavaScript code in
these places:

. State entry/exit/do operations
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. Transition guard/effect

. BPMN Activity Loop Conditions and
Sequence Flow Condition Expressions

With the exception of the guard, all of
these should be one or more valid
JavaScript statements, including the
semi-colon.

The guard must be a valid Boolean
expression, also terminated with a
semi-colon.

Variables that are members of 'sim’' or
'this' are listed in the Locals window
when a Simulation breakpoint is reached.

sim.count = 0;

Input When JavaScript 1s enabled, you can type
script commands in this field that will
execute prior to the Simulation being run.

Post Using a Post Simulation Script, you can
Processing run JavaScript after the Simulation ends.
Script Type in the qualified name of a script

from the model script control.

For example, 1f you have a script named
'MyScript' in the Script Group
'MyGroup', type in the value
'MyGroup.MyScript'.
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OK Click on this button to save your changes.

Notes

. Usually all Simulation elements and relationships reside
within the Package configured for Simulation; however,
you can simulate diagrams that include elements from
different Packages, by creating Package Import
connectors from the configured Package to each 'external’
Package (alternatively, for a BPSim model, create a
Dependency connector from the configured Package to
cach external element)
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Activate Simulation Script

An Execution Script is configured for a model Package
defining the Simulation parameters. The most common
reason for activating an Execution Script is when multiple
Simulation Scripts are configured against a Package and you
want to run a specific one.

Access
Ribbon Execute > Tools > Analyzer
Develop > Preferences > Analyzer
Analyzer Click the Analyzer Script checkbox to
Window make it active

Keyboard Shift+F12
Shortcuts

Activate a Simulation Script for Execution

Ste Action
p
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1 | Inthe Execution Analyzer window, select the
required Execution Script. This makes it the current
default for your open model, so that clicking on the
Simulation Run button will automatically invoke
this Stmulation Script.

Execution Analyzer x
§ e *

+-1 7 Project Models.Execution Analysis., NET

+ Project Models.Execution Analysis.C++/Mative

+ Project Models.Execution Analysis.)ava

+ Project Models.Execution Analysis.Simulation Interaction Models

{F> Project Models.Execution Analysis.Simulation.State Machine Models
: e[ 5l] EA Bcamiple Models.Execution Analysis.Simulation.5tate Machine Models
+-17 Project Models.Execution Analysis.Simulation. Activity Models

2 Click on the checkbox to the left of the script to
activate it.

3 | Select the 'Simulate > Simulator > Open Simulation
Window' ribbon option to execute the simulation.
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Run Model Simulation

A Simulation executes the model step-by-step, enabling you
to validate the logic of your behavioral model. The current
execution step 1s automatically highlighted in the model's
diagram to make it easy to understand the various processes
and state changes as they occur during the Simulation.

There are several ways to start a model Simulation:

. When the active diagram can be simulated, the Run
button on the main Simulation window will process the
current diagram, either by running an existing script or
defining a new temporary one

. When the active diagram can not be simulated, the Run
button on the main Simulation window will run the
Simulation for the active Execution Analyzer script

. By right-clicking on a Simulation script in the Execution
Analyzer window and selecting the 'Start Simulation'
option

. By right-clicking on a suitable diagram and selecting one
of the 'Execute Simulation' options

There are visual cues during execution. When the
Simulation is running, Enterprise Architect will actively
highlight each active node for each executed step. In
addition, all outgoing transitions and control flows will be
highlighted, showing the possible paths forward. Elements
at the end of possible paths forward will be de-emphasized
to half-strength and any other remaining elements will be
90% 'grayed out'. This provides a very dynamic and easy to

c) Sparx Systems age 250
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follow execution that continually refocuses attention on the
execution context.

Access

Ribbon Simulate > Dynamic Simulation >
Simulator > Open Simulation Window

Simulate > Run Simulation > Start

Edition Specific Details

In the Professional Edition, if a branch is encountered in the
execution, the Simulator prompts you to choose the
appropriate path to take in your execution.

In the Corporate, Unified and Ultimate Editions, in which
JavaScript 1s enabled, the Simulation will automatically
evaluate all guards and effects and dynamically execute the
Simulation without user intervention. If the Simulation
becomes blocked due to no possible paths forward
evaluating to True (or multiple paths evaluating to True)
you can modify the Simulation variables on the fly using the
console input of the Simulation Execution window.
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Run a Simulation Using the Toolbar

Simulation O x

e

00 £ 52 %= O |Interpreted -| Tools - |50 3

[02434152] Configuration: mode: Interpreted simulation, platform: UML Basic
[02434153] Preparing Simulation Data
[02443102] Loading Machine
[02443209] Simulation Started
[02443212] Process Order
{ [02443738] Process Order ActivityInitial
[02444264] Process Order.Receive Order
[02444787] Process Order.Decision

4 4

Icon Action

- Start the Simulator for the current
diagram or, if the current diagram cannot
be simulated, run the Simulation using
the activated Simulation script.

A Pause the Simulation.

L= 5z oz When the Simulation is paused, step over,
step in and step out to control the
Simulator's execution at the required step
in the model Simulation.
Stop the Simulation.

Click on the drop-down arrow and
select the type of Simulation to run:

. 'Interpreted' - Perform dynamic

c) Sparx Systems age 270
(c)S S 2021 P 27 of 148



Dynamic Simulations 2 September, 2021

Manual ¥ execution of a Simulation (Corporate,
— Unified and Ultimate Editions)

Interpreted

Executable

. 'Manual' - Step through a Simulation
manually (the only option available in
the Professional Edition)

. 'Executable' - Select when running the
Simulation on an Executable
StateMachine

Todls - Click on the drop-down arrow and
select from a menu of options for
performing specific operations on the
Simulation script and output, such as
Build, Run, Generate and View
Breakpoints.

® = Vary the execution rate of the Simulation,
between 0% and 100%; at:

. 100%, the Simulation executes at the
fastest possible rate

. 0% the Simulator breaks execution at
every statement

Notes

. The Simulation tool only becomes active when a valid

(c) Sparx Systems 2021 Page 28 of 148



Dynamic Simulations 2 September, 2021

Simulation Execution Script is activated

. You can set a Simulation script as the current default by
setting its checkbox in the Execution Analyzer window
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Simulation Breakpoints

The 'Simulation Breakpoints' tab of the Breakpoints &
Events window enables you to interrupt and inspect the
Simulation process.

When dynamically executing a Simulation (in the
Corporate, Unified and Ultimate editions) the process will
proceed automatically - if you want to stop execution at
some point to examine variables, inspect Call Stacks or
otherwise interact with the Simulator, you can set a
breakpoint on a model element in much the same way as
you would with a line of source code. When the Simulator
reaches the breakpoint, execution is halted and control
returned to Enterprise Architect.

Access
Ribbon Simulate > Dynamic Simulation >
Breakpoints > Simulation Breakpoints
Breakpoints

The Simulation executes the model step-by-step, enabling
you to validate the logic of your behavior model; the
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Simulation halts when it reaches an element defined as a
breakpoint.

The UML elements that can be defined as breakpoints
include Actions, Activities, States, and most other
behavioral nodes such as Decision, Initial, or Final.

The UML relationships that can be defined as breakpoints
include Interaction Messages.

The breakpoints are stored as Breakpoint Sets for a given
Enterprise Architect project.

Elements that are included in a Simulation and that have
breakpoints are marked by a green circle near the top left
corner of the element, whilst the Simulation 1s in progress. If
the Simulation is not running, the green circles are not
displayed.

When JavaScript 1s enabled all Simulation variables will be
displayed in the Locals window, and it is possible to modify
these Simulation variables using the Simulation window's
console input field (underneath the Toolbar).

Toolbar Buttons

Item Description
Y Enables all breakpoints defined in the

current Breakpoint Set for the Simulation
session.
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Deletes all breakpoints defined in the
current Breakpoint Set for the Simulation
session.

Disables all breakpoints defined in the
current Breakpoint Set for the Simulation
session.

Adds a breakpoint for the selected
clement or Sequence message to the
current Breakpoint Set.

Changes the selected Breakpoint Set for
use 1n the Simulation session.

Performs Breakpoint Set commands:
. New Set: Create a new Breakpoint Set

. Save As Set: Saves the current
Breakpoint Set under a new name

. Delete Selected Set: Deletes the
current Breakpoint Set

. Delete All Sets: Deletes all Breakpoint
Sets saved for the diagram

Page 32 of 148



Dynamic Simulations 2 September, 2021

Objects and Instances in Simulation

As a given business, system or mechanical process executes,
the Activities and Actions within it might generate objects
of a specific type and perform operations on those objects,
perhaps even consuming or destroying them. You can
simulate the creation, use and consumption of such objects
using a Simulation model that represents the objects and
actions with model elements such as Classes, Instance
Objects, attributes, operations and Ports (ActionPins and
ObjectNodes). The model can also create, act on and destroy
several different objects at different stages as part of the
same process. Representing model data or objects in
Simulation makes the Simulation more accurately reflect the
real process.

Object Concepts
Term Description
SimType The type of Simulation element, such as

Class, Enumeration or Interface. These
can be classifiers of objects in a
Simulation.

SimObject An object that is an instance of (is
classified by) a SimType element.
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Attribute A property of a SimType element, or of a
specified node such as an ActivityNode.

Operation A behavior of a SimType element, or of a
specified node such as an ActivityNode.

Port A Port of a Class or Object, an ActionPin
of an Action, or an ObjectNode of an
Activity. Ports of classifiers are a type,
whilst a Port of an object is a realization

of the type.
Parameter/ Parameters of Operations; Activity
Activity Parameters are, specifically, parameters
Parameter of ActivityNodes.
Slot A realization of an attribute in an object.

A Slot has a run time value that can be
initialized by the run state value of the
Slot. If these values don't exist, the
system uses the initial values of the
attributes.

Runtime All objects exist in the JavaScript runtime

Environment = environment, so you can use JavaScript
to create or change simulation objects and
simulation variables.
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Display All simulation objects, Simulation

Variables variables or events are identified on the
Locals window while they are in effect.
In some cases, to show the variables you
might need to add break points to the
model to pause processing while the
variable exists.

As all objects and variables are shown,
global variables that exist outside the
simulation but that are significant to it -
such as the parent Class and Activity
elements within which a process is
defined - are automatically also
represented as default object variables. So
too 1s the anticipated output of the
Activity, as a return variable.
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Create Objects in a Simulation

In a Simulation model, you can create Classes and either
create instances of them (Global Objects) to represent
objects that exist in the process, or define Actions to
generate one or more Objects at any point during the
process.

You have three options for creating Objects in a Simulation
model:

. Manually create the Object

. Dynamically create an Object through a CreateObject
Action element

. Use the JavaScript function sim.CreateObject ("name") as
the 'Effect' of an Action element, to again create an Object
dynamically

Having created an Object dynamically you can also
instantiate any inner objects of that Object, such as an
Activity on a Class, and act on the properties of that inner
object.

Manually Create an Object

Simply create an Object element on a diagram in the model,
either by:

. Dragging an Object element from the 'Object' pages of the
Diagram Toolbox and setting its classifier, or

. Dragging a classifier element from the Browser window
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and pasting it into the diagram as an instance

In the Stmulation model you can then set up the Object
properties themselves (such as setting run-states to re-set the
initial value of an attribute) or the behaviors of Actions to
act on the Object (such as passing it along a process flow)
and observe what happens to the Object in a Simulation.

Create an Object through a CreateObject
Action

If your process generates objects in runtime, you can
Simulate this using a CreateObject Action.

Ste Action
p

1 | On your Activity diagram, drag an 'Action' icon from
the Diagram Toolbox, and select the 'Other |
CreateObject' context menu option to define it as a
CreateObject Action element.

2 | Set the classifier of the CreateObject Action to the
Class of which the Object will be an instance.

(Advanced | Set Classifier).

Create an Action Pin on the CreateObject Action, of
kind output.
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3 | Create or select the next Action in the processing
sequence, and add an Action Pin of kind input.

Connect the two Actions with a Control Flow
connector, and the two Action Pins with an Object
Flow connector.

CreateObject
Actiont:

Action?2

Class1

OutputPin ActionPin

4 | Perform a Simulation on the diagram. When the
CreateObject Action is executed, it creates an Object
having the properties of the classifier, and stores it in
its Output Pin. The Object itself is passed through
the Object Flow connection to the Input Pin of
Action 2, where its properties can be listed in the
Locals window for the Simulation.

Create Object Using JavaScript

You also can create Simulation objects dynamically using a
JavaScript command in the 'Effect' field of the Action
element. The command is:

sim.newObject = sim.CreateObject(""ClassName");
or
sim.newObject = new SimObject("ClassName"); (natural
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JavaScript)

That 1s: 'Simulate the creation of an Object based on Class
<name>'. The classifying Class would exist in the same
Package as the Action.

As for the CreateObject Action element, the Object is
created during the Simulation and can be passed down to
and processed by 'downstream' elements. In this example,
the created Object is 1dentified as sim.objectl and in Action
2 it 1s accessed and one of its attributes given a different
value (also by JavaScript as an Effect of the Action).

v

[ Action1 J
[ Action2 }

Instantiate Inner Objects

As described earlier, you can create an Object using either
JavaScript or a CreateObject Action. Similarly, you can
instantiate inner objects using JavaScript or a CallBehavior
Action.

In this example, using JavaScript, the Simulation first
creates a test object based on Class1. Class 1 has an Activity
element and diagram, with an Activity Parameter 1 set to the
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integer 5 and an Activity Parameter 2 set to the string 'test'.
The value of Activity Parameter 1 1s captured as a buffer
value 'buf'.

NP Create simulation object
o ociOmioct - oo ‘testObject
*Activitylnitial i el sn e SRS
Instantiate inner object
Actionz2 |77 Activityl”
sim.testObject. Activity1(5, "test
. . Aeccess param eter
. A_':'tmng ‘Activitylpamml’
zim.buf = gim testObject. Activity1.param

*ActivityFinal
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Destroy Objects in a Simulation

Having created or generated Objects in your Simulation
model, you can define Actions to destroy those objects at
any point during the process. All Simulation objects are
destroyed automatically when the Simulation completes.

You have two options for destroying the Objects in your
Simulation model:

. Dynamically destroy the Objects through a DestroyObject
Action element

. Dynamically destroy the Objects using JavaScript in an
Action element

The result of the deletion can be observed in the change of
local variables, on the Local window.

Destroy an Object through a DestroyObject
Action

Ste Action
p

1 | On your Activity diagram, drag an 'Action' icon from
the Diagram Toolbox, and select the 'Other |
DestroyObject' context menu option to define it as a
DestroyObject Action element.
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2

Set the classifier of the DestroyObject Action to the
Class of which the Object is an instance.

(Advanced | Set Classifier).

Create an Action Pin on the DestroyObject Action,
of kind input.

Connect the Input Action Pin to an Object Flow
connector from the last Action that operated on the
Object. In this example, the last Action that operated
on the Object 1s the Action that created it.

CreateObject

Action1: Class1 Action2 J

*Activityinitial

—

CutputPing:
Class1
DestroyObject
InputPint: Action3: Class1
Class1

*ActivityFinal

Perform a Simulation on the diagram. The process
passes the Object name or value into the Input
Action Pin as a parameter. When the DestroyObject
Action 1s executed, it deletes the Object having that
name or value from the model.

In the example, the instance of Classl is specifically
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destroyed before Action4 is processed, but the
results of Action2 are unaffected.

Destroy an Object using JavaScript

In the 'Properties' dialog of the Action element, in the
'Effect' field on the 'Effect' page, type either:

sim.DestroyObject ("objectname")
or

delete sim.objectFullName
For example:
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*Activitylnitial

[ Creation ]

Action2

[ Deletion }

Action3

*ActivityFinal

Notes

. In either case, you can also destroy a global object (one
that is created outside the process flow) by identifying the
Object to the Action performing the destruction; in the
case of the DestroyObject Action, by passing the Object
name from a Port on the Object to the Input Pin on the
Action through an Object Flow connector
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Dynamic Simulation with JavaScript

The Corporate, Unified and Ultimate editions of Enterprise
Architect provide the capability of using JavaScript to
evaluate guards, effects and other aspects of behavior within
the Simulation context. This provides for a fully automated,
intelligent execution of your State or Activity model, with
fine control over breakpoints, execution speed and
Simulation variables.

You can write JavaScript that uses any variables. To enable
you to display the values of such variables through the user
interface, two built-in objects are defined - sim and this -
whose members can be displayed in the Local Variables
window (also called the Locals window). Examples of the
variables that can be displayed are:

. sim.logger

. sim.Customer.name
. this.count

. this.Account.amount

The recommended convention is to add any global or
control variables not declared in the owning Class to the sim
object. In contrast, it would be normal to add attributes of
the owning classifier to the this object.

Some examples of where and how you can set Simulation
behavior using JavaScript are provided here. Further
examples are provided in the EAExample.eap model that
comes with Enterprise Architect.
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Using JavaScript
Setting Action
Analyzer If you enter JavaScript code into the

Script Input

Transition
and Control
Flow Guards

(c) Sparx Systems 2021

Execution Analyzer window 'Input'
field, this code will be injected into the
Simulation and executed before the
Simulation starts. This 1s useful for
establishing COM variables, global
counters, functions and other
initialization.

Platform: | UML Basic -

Options:

| Evaluate Guards and Effects using JavaScript

Input

sim.n=1;

This 1s the workhorse of the Simulation
functionality. As Enterprise Architect
evaluates possible paths forward at each
node in a Simulation, it tests the Guards
on outgoing transitions and control flows
and will only move forward if there is a
single true path to follow - otherwise the
Simulation 1s considered 'blocked' and
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Using COM
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manual intervention is required. You

must use the '==' operator to test for
equality.

¥* ControlFlow Properties

- General
Constraints
‘.. Tagged Values

Entry and Exit behavior can be defined
for States. Such code will execute at the
appropriate time and 1s useful for
updating Simulation variables and
making other assignments.

\Z Amber Operation: Change to amber

- Properties
General Behaviar:
.. Parameters simn =2
.. Behavior
- Advanced
- Tagged Yalues
= Rules
- Pre-Conditions
- Post-Conditions Show Behaviorin Diagram

You can also simulate the behavior of
Classes via their Object Instances, and
Activities in your model.

One very important feature of the
implementation of JavaScript in
Enterprise Architect's Simulator 1s that it
supports the creation of COM objects.
This provides the ability to connect the
running Simulation with almost any other
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local or remote process and either
influence the Simulation based on
external data, or potentially change data
or behavior in the external world based
on the current Simulation state (for
example, update a mechanical model or
software Simulation external to
Enterprise Architect). The syntax for
creating COM objects is shown here:

this.name="0dd Even";

var logger = new
COMObject("MySim.Logger");

logger.Show();
logger.Log("Simulation started");

Anywhere in Enterprise Architect that
has JavaScript code, such as in Dynamic
Simulation, you can now use a JavaScript
construct called 'Solver' (the Solver
Class) to integrate with external tools and
have direct use of the functionality within
each tool to simply and intuitively
perform complex math and charting
functions. The calls help you to
interchange variables between the built in
JavaScript engine and each environment
casily. Two Math Libraries that are
supported are MATLAB and Octave.

To use the Solver Class, you need to have
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a knowledge of the functions available in
your preferred Math Library and the
parameters they use, as described in the
product documentation.

Being part of the JavaScript engine, these
Solver Classes are also immediately
accessible to Add-In writers creating
model based JavaScript Add-Ins.

See the Octave Solver, MATLAB Solver
and Solvers Help topics for further
details.

It 1s possible to raise a signalled event
(trigger) directly using JavaScript. The
BroadcastSignal() command is used to
raise a named trigger that could influence
the current state of a Simulation. For
example, this fragment raises the signal
(trigger) named "CancelPressed".

BroadcastSignal("CancelPressed");

Note that a trigger named CancelPressed
must exist within the current Simulation
environment and must uniquely have that
name.

You can also call the signal using its
GUID. For example:

BroadcastSignal(" {996 EAF52-6843-4117
-8966-BCAAOABEC41F}");
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IS IN() The IS IN(state) operator returns True if
the current Simulation has an active state
in any thread matching the passed in
name. For example, to conditionally
control execution it 1s possible to write
code such as this:

if (IS_IN("WaitingForInput"))
BroadcastSignal("CancelPressed")

Note that the name must be unique within
all contexts.

Trace() The Trace(statement) method allows you
to print out Trace statements at any
arbitrary point in your Simulation. This 1s
an excellent means of supplementing the
Simulation log with additional output
information during execution.

The JavaScript Simulation will truncate
strings that exceed the defined maximum
length of the Trace message.
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Call Behaviors

In the course of simulating a process, you can enact the
behaviors defined in an operation of either a Class (through
its Simulation Object) or an Activity in the model. In each
case, you use JavaScript to call the behavior.

Invoke the Behavior of a Class

A Class in your model defines a behavior that you want to
simulate. This behavior 1s defined in the Behavior page of
an Operation of the Class.

For example, the Class is intended to add two integers,
through the Operation add(int, int). The integers in this

case are parameters of the operation, defined by attributes of
the Class, operandl and operand?.

4 Classl
B¢ operandl
B¢ operand2
» add(int, int)

Ste Action
p

1 | Inthe Properties window for the operation, select
the 'Behavior' tab and edit the 'Behavior' field to
apply the JavaScript Simulation Objects (this or sim)
to the behavior definition.

In the example:
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this.operand | =operand1;
this.operand2=operand?2;
return operand1+operand?2

2 | Drag the Class onto your Simulation Activity
diagram and paste it as an Instance.

In the example, the Object is called 'calculator'. For
clarity, the element shown here is set to display
inherited attributes and operations, and the behavior
code, on the diagram.

calculator: Class1

sClasst
- operandi:int
- operandz2: int

Classt
+ add(int, int): int

R . e

3 On the Simulation diagram, for the appropriate
Action element, open the 'Properties' dialog and on
the 'Effect’ page type in the JavaScript to capture and
simulate the Object's behavior.

In the example, the JavaScript defines a value that
will be provided by simulating the behavior of the
operation from the Object, as performed on two
provided integers. That is:

sim.result=sim.calculator.add(7,9)
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4 | Run the Simulation, and observe its progress in the
Locals window. Ultimately the Class behavior is
reflected in the result of the Simulation.

In the example: result = 16.

Invoke the Behavior of an Activity

An Activity element can have a behavior, defined by an
operation in that element. As a simple example, an Activity
might have an operation called Get Result, with the behavior
return "ON";.

You can simulate this behavior in the Activity's child
diagram (that 1is, internal to the Activity), with a JavaScript
statement in the appropriate Action element's 'Effect' field.
In the example, this might be:

sim.result=this.GetResult();

The statement invokes the parent Activity's operation
GetResult and assigns the outcome of that operation's
behavior to sim.result. You can observe the progress of the
Simulation and the result of simulating the behavior in the
Locals window, where (in this example) the value result
"ON" will ultimately display.
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Interaction Operand Condition and
Message Behavior

When you simulate the behavior of a Sequence diagram,
you can use a Condition for the CombinedFragment
Interaction Operand, to control the flow during the course of
the Simulation.

A Message in Sequence diagram can link to an Operation,
so the behavior of the Operation can also be used during the
course of the Simulation.

Interaction Operand Conditions

Field/Column | Description

Operand Interaction Operand Conditions are

Condition conditional statements that are evaluated
whenever the Simulator has to determine
which path to take next. Operand
Conditions typically have these
characteristics:

. Defined in the 'Combined Fragment'
dialog

. Written in JavaScript

. Can refer to variables defined during
Simulation
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Adding To add an Operand Condition:
Opefé}f{d 1. Double-click on the
Conditions CombinedFragment element to open

the 'Combined Fragment' dialog.
2. Click on the New button.

3. In the 'Condition field', type the
JavaScript for the condition.

4. Click on the Save button.

Combined Fragment ﬁ
Type: I ak - I
Mame: at2

Interaction Operands

Condition
zim loop_count %2)==1|

[sim loop_court%2)==0

Delete I l Mew I I Save I
| ok | | Cancel |
—
Evaluation During execution the Simulator evaluates
Semantics any Operand Condition within the

CombinedFragment; the
CombinedFragment type and the outcome
of the evaluation can determine the path
that the Simulation continues on.
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Guards and Effects

Guards and Effects are used to control the flow of the
Simulation and to execute additional actions or effects
during the course of a Simulation.

Guards and Effects

Concept Detail

Guards Guards are conditional statements that are
evaluated whenever the Simulator has to
determine the path to take next. Guards
typically have these characteristics:

. Defined on transitions and control
flows to govern how a Simulation
proceeds

. Written in JavaScript
. Can refer to variables defined during

Simulation
Adding Guards are defined on the Transition or
Guards Control Flow in the 'Properties’ dialog for

the selected connector. A Guard is
typically a piece of JavaScript that will
evaluate to either True or False. For
example, here is a conditional statement
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that refers to a current variable (Balance)
being greater than zero. Note the use of
the prefix 'this’ to indicate that the
variable 1s a member of the current Class
context.

Guard: this.Balance =0;

Effect is a Behavior
Effect:

During execution the Simulator will
examine all possible paths forward and
evaluate any guard conditions. This
evaluation could establish that:

. A single valid path forward evaluates
to True; the Simulator will follow that
path

. Two valid paths exist; the Simulator
will block, waiting for some manual

input via the console window to resolve
the deadlock

. No valid path exists; the same response
as when two paths are found - the
Simulator waits for the user to change
the execution context using the console
window

. No paths evaluate to True but a default
(unguarded path) exists; the Simulator
will take the unguarded path
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Effects Effects are defined behaviors that are
executed at special times:

. On entry to a state
. On exit from a state

. When transitioning from one state to
another (transition effect)

Effects can either be a section of
JavaScript code or a call to another
Behavior element in the current
simulation.

JavaScript A JavaScript effect might resemble this

Effects example, in which the Balance variable 1s
decremented:
Guard:
Effect iz a Behavior

Effect: this.Balance—;
Call In this example the Effect is a call
Behavior behavior effect. In this case, it calls into a
Effects model the Activity named Decrement

Balance that 1s defined elsewhere. The
simulation will then enter into that
diagram/behavior and continue to execute
until returning to the point at which the
Effect was invoked.
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Guard:
| Effect is a Behavior
Hffect: Decrement Balance| . | |

Order of In complex simulations that might
Execution of  involve transitioning out of deeply nested
Effects states into other deeply nested states in a

different parent context, it i1s important to
consider these rules concerning the order
of execution:

. All exit actions (Effects) encountered
leaving a nested context are executed in
order of most deeply nested to least
deeply nested

. All actions (Effects) defined on
transitions are executed next

. Finally, all entry Effects are executed
from the least deeply nested context to
the most deeply nested

So the basic rule is: all exit actions,
followed by all transition actions, and
finally all entry actions.

Note on JavaScript variables to be accessed and
JavaScript referred to during Simulation execution
Variables belong to either:

. sim (for example,
sim.pedestrianwaiting) - typically used
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for global Simulation variables, or

. this (for example,
this.CustomerNumber) - typically used
to refer to owning Class attributes

This is important to let the JavaScript
engine know you are referring to a
Simulation variable and not a simple
local variable used during, for example,
basic calculations. You can create
Simulation variables of arbitrary scope
and depth - for example,
this.customer.name is a legitimate
qualified name.
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Triggers

Triggers represent signals and events that can activate
transitions leaving the current state(s). A trigger might
represent a real world signal or event such as:

. A button being pressed

A message being received
A pedal being depressed

A switch being thrown

A state in a concurrent region being entered or exited

For a trigger to have an Effect

. Transitions must be defined that will fire when the
simulation receives the Signal or Event

. The current Simulation State(s) or its parent(s) must have
an outgoing transition that accepts that trigger

. The transition activated must be unguarded or have a
guard that will evaluate to True

Managing Triggers

Action Detail
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Creating Triggers are either created as an instance

Triggers of a Signal element or as an anonymous
event. Triggers are connected to
Transitions in the "Transition Properties'
dialog as shown here. In this example a
Trigger named 'Pushdown' has been
defined based on the Signal
'Signal Pushdown'.

. Omitting the Type and Specification
details results in a simple anonymous
Trigger.

. If parameters are needed, these are
defined on the Signal and must be
supplied at the time the event fires

Triggers

Mame: Pushdown E]
Type: Specification  Signal_Pushdown E]
MName Type Specification
Pushdown Signal Signal_Pushdown

A trigger will appear in the 'Project' tab of
the Browser window, as illustrated here:

& Pushdown
A ‘. [@ Pushup
Signal_Pushdown

Using Triggers are deployed by connecting

Triggers them to transitions, as in the earlier
example, and are used during simulation
by 'firing' them into the running
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simulation as required.

When using triggers these points should
be taken into account:

. A 'triggered' transition can not take
place until its effective trigger 1s
signalled or fired

. When a trigger is received 1t will
activate all current waiting transitions
dependent on that trigger (that 1s, the
trigger 1s broadcast)

. Triggers are evaluated on all transitions
for all parents of a current child state;
this allows a parent state to exit all
child states 1f necessary

. Once used in a simulation, a trigger 1s
consumed and must be re-fired if
needed again

. Sets of triggers can be saved and either
manually or automatically fired to
facilitate automated model simulation
under different event models

Firing triggers means to signal or activate
a trigger within the current simulation.
This could activate zero, one or many
waiting transitions depending on the state
and concurrency of the current
Simulation.
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Firing triggers can be achieved in many
ways. The most efficient is the 'Waiting
Triggers' list.

During the course of model Simulation, if
the Simulator reaches an impasse due to
required triggers not being available
(fired), the list of all possible candidate
triggers 1s shown in the 'Waiting Triggers'
list of the Simulation Events window.

Waiting Triggers

[ Hold
[ Pushdown

Double-clicking a trigger in this list will
fire 1t into the Simulation. Other ways to
fire a trigger include:

1. Double-click an un-signalled trigger in
the Events window.

Sequence | Trigger Status Type Parameters
e Pushdown not signalled  Signal
[ Pushup not signalled  Simple

You can also use the context menu on
these events to either signal an
un-signalled event, or to re-signal an
event that has already been fired
previously.

2. Use the context menu of the Transition
required to fire and select the 'Signal
Trigger in Simulation' menu option.
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Action Behavior By Type

You can vary the behavior initiated by an Action element by
defining (or even redefining) its type. In Simulation, you
can apply and observe a number of different behaviors using
the Actions 1n the types and groups described in this table.

Action Types

Type

Object
Actions

Variable
Actions

(c) Sparx Systems 2021

Description

Object Actions operate on an object in a
specific way, such as creating, destroying
or reading the object. They include:

. CreateObject
. DestroyObject and
. Read Self

Variable Actions have an association
variable in the form of the Tagged Value
variable with the value of the name of an
object in run-time. They provide the
variable not only as an object but also as
a property (such as an attribute or Port) of
an object. They include:

. ReadVariable
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WriteVariable
ClearVariable
AddVariableValue
RemoveVariable

StructuralFeature Actions operate on a
structural feature, namely an attribute of
an Activity or of the classifier of an
object. They include:

ReadStructuralFeature
WriteStructuralFeature
ClearStructuralFeature
AddStructuralFeatureValue
RemoveStructuralFeatureValue

Invocation and Accept Event actions
define the Triggers and Signals of an
event. They include:

SendSignal
BroadcastSignal
AcceptEvent
SendObject
CallBehavior
CallOperation
AcceptCall

The ValueSpecification Action evaluates
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s Actions a value; 1t must have an input value and
some evaluating code as its behavior or
effect.
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Structured Activity Simulation

One of the more complex structures in a behavioral model 1s
a Structured Activity, which models a series of actions
either in a nested structure or in a process of assessment and
execution. The assessment types of Structured Activity are
the Conditional Node and Loop Node, both of which you
can simulate quite easily.

Conditional Node

A Conditional Node essentially consists of one or more
pairs of Test / Body partitions, each pair being referred to as
a Clause. The Test partition is composed of Activity
diagram elements that test a condition, and if that condition
1s met further Activity diagram elements in the Body
partition are executed to produce a result.

If there 1s one Clause, the Conditional Node either outputs
the result of the Body partition, or no result. If there is more
than one Clause, control flows from one Test to the next
until either a condition 1s met and a Body partition is
executed to produce a result, or all Tests fail.

Simulation currently supports use of the 'Is Assured'
checkbox setting in the 'Condition' tab of the Properties
window. The other two checkbox settings are ignored. If the
'Is Assured' checkbox is:

. Selected, at least one Test must be satisfied, so its Body i1s
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executed and a result output; if no Test 1s satisfied and no
result output, the Conditional Node 1s blocked and
processing cannot continue beyond it

. Not selected, a Test can be satisfied and a result output,
but i1f no Test 1s satisfied and no result output, processing
can still continue beyond the Condition Node

You can simulate a range of possible paths and outcomes by
typing JavaScript sim. statements that define or lead to
specific Test results and Body results, in the 'Effect' fields of
the Action elements within each partition of each Clause.
These sim. statements must identify the full path of the
Conditional Node, Clause and Output Pin being set. For
example, in a test to see if a person qualifies as a senior
citizen:

if (sim.Person.age >=65)

sim.AgeCondition.Clausel.Decider1=true;

else

sim.AgeCondition.Clausel.Decider1=false;

The Condition Node is called AgeCondition, the test is in
Clausel and the OutputPin for that test 1s Decider 1.

Loop Node

A Loop Structured Activity Node commonly represents the
modeling equivalents of While, Repeat and For loop
statements. Each Loop Node has three partitions:
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. Setup - which initiates variables to be used in the loop's
exit-condition; it 1s executed once on entry to the loop

. Test - which defines the loop exit-condition

. Body - which is executed repeatedly until the Test
produces a False value

You define the Loop Nodes by dragging Activity diagram
elements from the Toolbox pages into the Setup, Test and
Body partitions. The Body partition can contain quite
complex element structures, defining what the Loop Node
actually produces in the process.

The Loop Node has a number of Action Pins:

. Loop Variable (Input) - the initial value to be processed
through the Loop

. Loop Variable (Output) - the changing variable on which
the Test 1s performed

. Decider - an Output Pin within the Test partition, the
value of which is examined after each execution of the
Test to determine whether to execute the loop Body

. Body Output - the output value of the processing in the
Body partition, which updates the Loop Variable Output
Pin for the next iteration of the loop, and

. Result - the value of the final execution of the Test
partition (which is the value passed back from the last
execution of the Body partition)

You can simulate the effects of different actions and outputs
through the Loop, by typing JavaScript sim. statements that
define or lead to specific Test results and Body results, in
the 'Effect' fields of the Action elements within each
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partition. These sim. statements must identify the path of the
Loop Node and Output Pin being set. For example, in an
Action 1n the Test partition:

sim.LoopNodel.decider =
(sim.LoopNodel.loopVariable>0);
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Activity Return Value Simulation

An Activity is likely to produce a return value as the output
of the process it represents. You can simulate how that
return value 1s passed on to the next stage in the process,
under three scenarios:

. The Activity simply produces a return value, which is
passed directly to the next Action

. The Activity has one or more Activity Parameters -
represented on a diagram by Activity Nodes - that accept
input values to or hold output values from the child
Actions of the Activity, and the output Activity Parameter
collects and passes on the return value

. The Activity 1s instantiated by a CallBehavior Action that
replicates the behavior of the Activity and passes the
return value onwards

Activity Return Value Pass Out

(This method 1s unique to Enterprise Architect simulation,
mimicking the effect of an Activity Parameter without one
having to exist.)

The Activity has a return value, which is transferred from
the Activity element to an Action Pin on the next Action in
the process via an Object Flow connector.
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V/

Activity1: Integer
oo

Action2

ActionPin1:
Integer

You can simulate this by setting a simple JavaScript
statement to set the return value in the Activity's child
element (such as this.return=12;) and, running the
simulation, see the value transferred to the Action Pin in the
Locals window.

Activity Parameter Pass Out

If the Activity has an Activity Parameter, its value passes to
the corresponding Activity Node and then, via an Object
Flow connector, to the Input ActionPin of the next Action in
the process, as shown:
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v

ActivityParameter1: Activity1
Integer

\%E{ Action2 J
ActionPini:

Integer ‘

In the Locals window, you can either observe the
Parameter's default value pass through to the ActionPin, or
you can use JavaScript in the Activity's child Actions to
simulate an update of the value within the Activity. For
example:

this.ActivityParameter1=20;

CallBehavior Action

An Activity might be used a number of times in a process,
in which case you might want to generate a separate
instance of the Activity each time. You can do this using a
CallBehavior Action to create an object of the Activity and
execute 1ts behavior. The input and output Activity
Parameters are bound to corresponding input and output
Action Pins (arguments) on the CallBehavior Action.
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outValue: \v

Integer
Action1
sim_Action1.outValue = 5;

inParam:

Integer
Action2: Activity1 }
jﬁ rh !

outParam: CallBehavior
Integer

atraces

Y
Activity1
— Action2 J
ActionPin2- inParam: OO outParam:
Integer ‘ Integer Integer

When you simulate the part of the process containing the
Activity, you provide an input value (as in Action 1) that
passes into the input Action Pin on the CallBehavior Action,
which creates an Object of the Activity. The CallBehavior
executes the behavior of the Activity, using the input Action
Pin to act as the input Activity Parameter, and the Output
Action Pin to receive the return as the output Activity
Parameter. The Activity return value is then passed to an
Action Pin on the next Action, using an Object Flow
connector. You can provide JavaScript statements in the
Actions of the Activity to act on the input value and
generate a return value, such as:

sim.buf=this.inParam; and
this.outParam=sim.buf + 11;
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Simulation Events Window

The Simulation Events window is where you manage
triggers and sets of events in a simulation. Its main functions
are to:

. Add, delete and re-sequence a set of triggers for a
simulation

. Display a list of fired, lost and waiting events for the
current running simulation

. Provide options to fire any arbitrary trigger into the
current simulation

. Provide a convenient "Waiting Triggers' list of triggers
that the simulation is waiting on

. Save trigger sets for later use in both manual and
automated simulations

. Accept triggers dragged from the Browser window into
the current list

. Enter trigger parameters for a waiting trigger prior to
firing

As triggers are consumed in the simulation, their status and
position is logged in the main body of the Simulation Events
window.

You can save the log of fired triggers as a trigger set or
event set to reapply in another Simulation run, which you
can execute manually or automatically. See the topic
Trigger Sets and Auto-Firing for more information on
building and using Trigger sets.
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This image illustrates the Simulation Events window during
execution.

Simulation Events X
<no event set> lE- 4t £ % @ o
Sequence Trigger Status Type Parameters Event Time Waiting Triggers

= PlayList not signalled  Signal Marme PlayList +  [@PowerOn
= PlaySong not signalled  Signal Marme PlaySong

= PowerOn not signalled  Signal PowerOn

= PowerOff not signalled  Signal PowerOff

= SetRepeat not signalled  Signal SetRepeat

= Stop not signalled  Signal Stop e

4 111} 2
Ribbon Simulate > Dynamic Simulation > Events

Column Details

Field/Column Action

Sequence During and after the simulation, indicates
the position in the sequence in which a
trigger was fired or is expected to be
fired. Note that if a trigger is fired out of
sequence, it will be moved to the bottom
of the signalled events section.

Trigger The name of the trigger - identifies the
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Status

Type

Parameters
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Trigger used to initiate the event.

Indicates the status of the Trigger. Values
can be:

. used - the trigger has been fired and
processing has passed on

. lost - the trigger has been fired in the
list, but 1t had no effect

. signalled - a trigger was fired and
consumed by one or more transitions

. not signalled - the trigger has not yet
been fired

Indicates the type of trigger. Currently
only supports:

. Signal
. (no type) an anonymous trigger

For a Signal Trigger, initially shows the
parameters required for firing by the
Signal specification. For example a
"Login" signal might include username
and password parameters - and each
triggered invocation can use different
parameters.

Each time the simulation fires the trigger,
the system will prompt you for values.
You can also edit the values directly in
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Event

Time

Waiting
Triggers
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the list when the trigger is set to not
signalled.

Parameters are very useful for testing the
conditional logic in your simulation and
to simulate a variety of inputs and data
coming in from outside the simulation.

For a:

. Signal Trigger, identifies the Signal
specification

. For anonymous Triggers has no value

The simulation time at which the trigger
was signalled. Note that this 1s an
absolute (real world) time, and not a
relative simulation event time.

Lists the Triggers available for selection
from the current state(s), including those
where more than one trigger is possible at
a single transition. Double-click on a
trigger to add and signal it as the next
trigger in the current event sequence.

You can show and hide this panel by
clicking on the gray arrow just above the
panel.
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Toolbar Items

Option Action

setl " Use this drop list to select and work with
previously defined trigger sets.
Before running a simulation, select a
previously-defined trigger set to use for
the next simulation run. You elect to not
use a trigger set by selecting the <no
event set> option.

SR Click to create and delete trigger sets:

. Save Set - Save the current trigger list
as a new trigger set; the system
prompts you for a name for the new set

. Save Set As - Create a copy of the
current set under a new set name

. Delete Selected Set - Delete the current
trigger set

. Delete All Sets for Diagram - Delete all
saved trigger sets for the current
diagram

¢ Move the selected trigger one line down
in the firing sequence of triggers.

This option is not available if there are no
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signaled triggers below the selected line.

1 Move the selected trigger entry one line
up 1n the firing sequence of triggers.

This option is not available if there are no
signaled triggers above the selected line.

f Click to fire the selected trigger. You can
also fire the trigger by double-clicking on
it.

_ Click to toggle auto-firing on and off.

Auto-firing will fire the un-signalled
triggers in your trigger set sequentially. If
your set matches a valid execution path,
then the simulation will run
automatically. Out of sequence or unused
triggers will be 'lost'.

A breakpoint pauses the auto-firing and
you will need to click on the next trigger
to resume auto-firing the simulation.

e Delete the selected trigger(s) from the
list.

Context Menu Options
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Option Action
Signal Signal, or fire, the selected not signalled
Selected trigger.
Remove Remove a not signalled trigger from the
Selected sequence.
Re-Signal Fire a used or signalled trigger again.
Selected
Set All to Set all used or signalled triggers to not

Unsignalled  signalled.

Clear Trigger @ Clear all triggers from the window,
List regardless of their status.
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Waiting Triggers

When a simulation reaches a point where any change of
state (for any thread) requires a Trigger to proceed, the
simulation 1s effectively paused and control returns to the
system. The simulation is now effectively waiting for some
form of event (a real world signal) to proceed. The Waiting
Triggers list 1s useful in helping to determine which Trigger
should be manually signaled.

Access

Ribbon Simulate > Dynamic Simulation > Events

The right hand side pane lists available
Triggers.

The Waiting Triggers list on the Simulation
Events window is:

. Populated on each Simulation cycle with any Triggers that
would have an immediate effect if signalled

. Populated with a discrete set (any duplicates are not
shown as a Trigger is effectively broadcast to all
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transitions at once)
. Activated by double-clicking on the Trigger of interest

. Includes all possible triggers - including those activating
transitions on parents of currently nested states

This example shows that the current simulation has hit a
point where two possible Triggers can influence the flow of
execution.

Waiting Triggers
2 Hold
[ Pushdown

Due to the nature of Triggers and their effects, the list can
refer to each of these example situations equally validly:

. A single state has two outgoing transitions that are
respectively waiting for Hold and Pushdown; firing one of
these will activate the associated transition in the
simulation

. A single state has two or more possible triggers for the
same transition, such as a security camera being switched
on by a motion detector, sound detector or heat detector

. Two (or more) threads (concurrent regions) each have a
state waiting on either Hold or Pushdown; firing one of
these triggers will result in the thread(s) waiting on that

trigger to proceed while the other thread(s) will remain
blocked

. A child state 1s waiting on one of the triggers while a
parent state 1s waiting on the other; firing a trigger will
result in the associated transition being fired and either the
child or parent proceeding accordingly
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. Any combination of these
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Re-Signal Triggers

It 1s possible to re-signal a Trigger as a shortcut for dragging
in additional Trigger instances for signalling.

Access

Display the Simulation Events window, then right-click on
a Trigger within that window and select the 'Re-Signal
Selected' option.

Ribbon Simulate > Dynamic Simulation > Events
> right-click on existing trigger >
Re-Signal Selected

Trigger List

The Simulation Events window contains a list of Triggers
that have already fired. By right-clicking on a Trigger that
you want to signal again, you can use the context menu to
cause the re-signal to happen.

This image demonstrates re-signalling in action. When a
signal 1s re-signalled, a new copy 1s made and placed at the
end of the signalled triggers list, where 1t is automatically
fired again.
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Seq

uence | Trigger

D 2 | Pushup used
----- @ > | Pushdown used
----- @ 4 | Pushup used

Signal Selected

Removed Selected
Re-5Signal elected
Set All to Unsignalled

Clear Trigger List

Parameters
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Multi-threading - Forks and Joins

The Model Simulator provides the ability to handle
multi-threaded simulations using Fork and Join nodes.

. In the example, the current execution point has forked into
two threads, each with its own active node

. As this example progresses, the lower branch will wait at
the Join node until the top branch has completed all its
Actions

. Once the two threads merge back into one, the Simulation
will continue as a single thread until completion

. When automatically stepping, each thread will be seen to
execute a single step during one simulation 'cycle' -
although when single stepping or at a breakpoint, the
behavior is to alternate stepping between threads as each
thread receives processing time

. Note that the Call Stack window will show two active
threads and one 'paused' thread in the example; once the
threads merge there will be a return to single threaded
execution

. Also note that the Local variables are shared (global)
between all threads; if you want to Simulate private
variables on a thread you must create new Simulation
variables at the start of each thread - pre-loading such
variables with existing global data
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Trigger Parameters

Trigger parameters are arguments passed into the simulation
along with a trigger when it is fired. They allow for complex
behavior to be specified decision to be made based on
variables and data passed into a simulation at run-time by a
fired trigger (event).

Parameters

Parameter Detail

Introduction | To use trigger parameters you:

. First create a Signal element with the
appropriate attributes that will become
your parameters at run time

. On a suitable transition in your
diagram, create a trigger that is based
on the signal created earlier

. At run-time, will be prompted to enter
suitable parameters - they are then
passed in along with the trigger

Signals A Signal element is a template or
specification from which actual triggers
can be built. This example has two
arguments, a Name and a Password.
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Diagram
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These will be filled in at execution time
either manually or as part of a pre-defined
trigger set.

wsignals
Legin

- Mame :String
- Password Siring

The Trigger parameters 'prompt' that asks
for suitable values for each parameter.
Note that you need to enclose strings in
double quotes, otherwise the interpreter
will think you are referring to other
variables.

& | Trigger Parameter Entry

Property Walue

=1 Login
Mame "Jog"
Password "zecret”

This is an example diagram that makes
use of trigger parameters. At the Evaluate
Login state, the simulation examines the
variables passed in as trigger parameters
and makes a decision to either accept the
credentials or deny them.
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[this. Legin. Name=="Jo=" &2
this.Login. Password=="ssorat",]
Initil

Login Evaluate Login
Login

Chaoice

Jsim.LaginCount =D;

+ entry/ OnEnter

Retry [sim.LoginCount=2;]

Choice
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Trigger Sets and Auto-Firing

Trigger Sets are a powerful means of automating and
streamlining the execution, testing and validation of
simulation models. By re-using sets of triggers (with or
without parameters) it 1s possible to quickly and efficiently
walk through many simulation scenarios, either manually or
automatically using the 'auto-firing' tool.

Access

Ribbon Simulate > Dynamic Simulation > Events
About Trigger Sets

Aspect Details

Trigger Sets | . Stored with an associated diagram

. Made up of a list of Triggers in a set
sequence

. Can include Trigger parameters where
necessary

. Can be used manually by
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double-clicking Triggers to fire as
required

. Can be used as part of the 'auto-fire'
behavior to automate execution

. Managed from the Simulation Events
Window

Trigger sets can be created by manually
dragging triggers into the active triggers
list and then using the 'Manage Trigger
Sets' drop menu to save a new set.

It 1s also possible to save a set of triggers
built up during a single simulation setting
as a new set. This 1s convenient for
creating multiple test paths through a
simulation, based on saving the manually
fired triggers for each test case.

SRR #¥ | x

Save Set As..,

Delete Selected Set

Delete All Sets for Diagram

You can also delete a set and delete all
sets for the current diagram.

It 1s also possible to load a set, modify
parameters and/or order of firing and save
the set with a new name. This is a
convenient method for rapidly creating a
suite of simulation test scripts.
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Using Sets To use a trigger set you first select it by
name from the trigger set drop list as in
this example image. Once selected it
loads the Trigger List window with the
defined trigger set.

Note that the special item <no event set>
means no set 1s currently selected. At the
start of each simulation, if a set 1s
selected, 1t will be loaded afresh for the
next run. If <no event set> is selected,
the trigger list will be cleared.

Breakpoints & Events

Third Attempt Fl = -

<no event set> Status
Easic
Third Attempt |

Once you have selected a trigger set and
the list of triggers loaded you have two
options:

. Fire the triggers as required manually

. Use the auto-fire feature to fully
automate the simulation

Ereakpoints & Events

Third Attempt - B8-4 x

Sequence | Trigger Status Type Parameters

----- — Llogin  notsignalled Signal  Joeguessl
D Retry not signalled  Simple

D Login not signalled  Signal

D Retry not signalled  Simple

L Lagin not signalled  Signal

Auto-Firing | Auto-firing is a convenient way of
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streamlining your simulations. Once you
have loaded a trigger set, if you select the
Auto-fire button ' then Enterprise
Architect will automatically pick up
waiting triggers when it reaches an
impasse in the simulation. In practice,
this means that trigger sets matching
exactly a path through the simulation will
automatically run without your
intervention.

As you can save any number of trigger
sets with different pathways and trigger
parameters, you can effectively and
quickly test and work with many different
scenarios.

When a simulation runs with auto-firing
enabled, Enterprise Architect will wait
until a point is reached where the
simulation is 'blocked' or stable, waiting
on one or more triggers to advance the
simulation. At that time, the first unfired
trigger in the list will be picked up and
fired into the simulation. The outcome
depends on the relevance and perhaps on
the parameters of the trigger.

. If the trigger matches a 'waiting' trigger
it 1s immediately consumed and the
simulation advances
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. If the trigger matches no 'waiting'
trigger or possible parent transition,
then the trigger 1s 'lost' and the
simulation remains in the current state;
this corresponds to a scenario such as a
user pressing an 'on' button several
times in succession - there is no effect
other than that occasioned by the first
press
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Using Trigger Sets to Simulate an Event
Sequence

As a simple example of how useful trigger sets are, consider
this example trigger set and associated diagram.

In this example, using a user name and password, we
simulate a simple 'three strikes and you are out' login
process. The success path 1s waiting for the name "Joe" and
the password "secret". (Note - 1t is very important that
parameters referencing strings are enclosed in quotes,
otherwise the interpreter thinks the name refers to another
variable within the simulation.)

. Pass 1 tries Joe and guess! - which fails

. Pass 2 tries Joe and secret, but as they are referring to
variables, not strings - this fails as well

. Pass 3 shows the correct way of referencing trigger
parameters, and the simulation will succeed

Ereakpoints & Events

Third Attempt M= | x

Sequence | Trigger Status Type Parameters

----- — login  notsignalled Signal  Joeguessl
D Retry not signalled  Simple

D Login not signalled  Signal

D Retry not signalled  Simple

L Login not signalled  Signal

Here 1s a simple diagram simulating a login process
requiring a username and password pair.
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[this.Login.Mame=="Joe" &&
this.Login. Password=="seoret";]

CnLine

Choice

+ entry / OnEnter

[sim.LoginCount=3;]
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Multi-threading - Concurrent State
Regions

Concurrent regions within a State represent state changes
and processing that occurs in parallel inside one overall
parent State. This is especially useful when one region raises
events or modifies simulation variables that another region
1s dependent on. For example, one region could contain a
simulated timer which raised events on set intervals that
invoked state changes in the States within other regions.

Concurrent regions are essentially the same as Forks and
Joins with similar logic and processing rules.

In the example:

. When the transition to SalesProcess is taken, each region
is concurrently activated

. Credit 1s checked, the order totaled and the goods required
packed up

. However, in the event that the Credit Check fails, this
triggers the transition to the Sale Cancelled state; note that
when this occurs, the entire parent state and all owned
regions are immediately exited, regardless of their
processing state

. If the Credit Check succeeds, the region moves to the
final state and once the other regions have all reached
their own final state, the parent state can then be exited
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Sale Cancelled

[ChedCradit]
CreditoK

Choice
|[TotslGedes
AddCrder
o — =)
Initisl Finsl
[

o
Initial Finsal

Choice

( Paying )

. S
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Using Composite Diagrams

If you want to simulate processing that includes a branch
represented on a different diagram (for example, to reduce
complexity on the main diagram, or to hide areas of
processing that are only actioned under an exception), you
can use a Composite element to represent and access the
branch on its child Composite diagram. When you run the
simulation and it reaches the Composite element, it opens
the child diagram and processes it before returning (if
appropriate) to the main processing path. This 1s an
excellent method of following the processing path in a
complex process, representing sections of the process with
Composite Activity elements that expand the actual
processing in their respective child diagrams. You can have
several Composite elements representing different stages or
branches of the process.

One aspect to watch for (and that would be revealed by a
failure in the simulation) is to have multiple threads that
process simultaneously on separate diagrams. The
simulation cannot pass to a new diagram if it is also
following another thread on the current diagram.

This diagram provides an overview of an ATM cash
withdrawal process:
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Activitylnitial

Initialise

Withdrawal
Decision

I

Activity diagram

Double-chick to view the ATM

T

ATM Withdraveal

[sim.accntBalance == 0]

AcdtivityFinal
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The ATM Withdrawal Activity is a Composite element. If
you double-click on it, you open and display the child
diagram, which 1s a more detailed breakdown of the
withdrawal process. Similarly, a simulation will open and

process the child diagram.

t [ \1
o
o Hlnseﬂ CardH EnterPIN j EnterWithdrawal Accepth Dteij
fotivityInitisl
AcceptCard
ActivityFinal
PromptForAmount E{Enderhlnte] [Eject Card Printﬂeceipij
= A
=
=
rl-
Comect PIN
[sim.pin =
nOgog] Incomect PIN
[sim.pin <=
"9999"]

o
E
o [sim.regestegAmnt > [sim.reqestedAmnt
E sim.accontBalance] =
2 VerifyPIN sim.accntBalance]
=
&
m CheckBalance
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Win32 User Interface Simulation

Enterprise Architect supports the simulation of dialogs and
screens created with the Win32® User Interface profile, to
integrate user interface design with defined system behavior.
Dialogs can be programmatically referenced and invoked
using JavaScript commands within a behavioral model such
as a StateMachine, providing a fully customizable and fully
interactive execution of your behavioral model.

Button controls can be used to broadcast signals, firing a
trigger when the button 1s clicked. Signal arguments can be
filled from the dialog input fields; for example, to capture
and send a username and password for evaluation.

Dialogs designed using the Win32 User Interface profile
(and existing within the same Package branch as the
behavioral model being executed) will be created as new
windows in the background at the beginning of simulation.
Various properties that can affect the appearance and
behavior of each dialog and control can be customized at
design time via Tagged Values provided by the Win32 User
Interface profile.

To interact with a dialog via JavaScript during simulation,
the 'dialog' simulation-level keyword is used, followed by a
period and the name of the dialog. Properties and methods
can then be accessed; for example, to show the dialog, or to
set the text value of an 'Edit Control':
dialog.Login.Show=true;
dialog.Login.Username.Text="admin";
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Examples

To view an example of the Win32 User Interface
Simulation, open the EAExample model and locate the
diagram:

Example Model > Model Simulation > StateMachine
Models > Customer Login > Customer > Customer Login

Common Properties

These common properties and methods are available on
most supported Win32 UI Control types.

Property/Met Description

hod
Enable Boolean

Enables or disables user interaction.
Move To Move the window to the specified

(x,y,width,he @ coordinates and set the window height
ight) and width.

Show Boolean
Show or hide the dialog. When this
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property is set to False, the dialog is
moved off-screen.

Text String
Set the title of the dialog or window.

JavaScript Functions

Function Description

BroadcastSig = Sends a signal to the simulation event
nal (string queue.

Signal) Parameters:

. Signal: String — the name of the Signal
to be broadcast

UlBroadcast | Sends a signal with additional parameters
Signal (string = to the simulation event queue.

Signal, array  Parameters:

Parameters) Signal: String — the name of the Signal

to be broadcast

. Parameters: Array — additional
parameters to be supplied for this
Signal

Example:
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ShowlInterfac
e (string
InterfaceNam

e, boolean
Show)

InterfaceOper
ation (string
InterfaceNam
e, string
ControlName
, string
OperationNa
me,[string
argl],[string
arg2])

Getlnterface
Value (string
InterfaceNam
e, string
ControlName
, string
OperationNa
me,[string
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UlBroadcastSignal("Login", {Name:
dialog.Login.Username.Text, Password:
dialog.Login.Password.Text});

Deprecated. See the Show property on
the 'Dialog' control. For example:

dialog.HelloWorld.Show = true;

Deprecated. Operations can be referenced
directly from the control. For example:

dialog.HelloWorld.ListControl.Insertltem
("Test", 2);

Deprecated. Properties can be referenced
directly from the control. For example:

dialog.HelloWorld.EditControl. Text;

Page 110 of 148



Dynamic Simulations 2 September, 2021

argl],[string
arg?])

Notes

. Controls must be within a dialog; any controls outside a
dialog will not be interpreted

. Dialogs and controls must be on a Win32 User Interface
diagram
. Simple UI controls and Basic UI controls can also be used

in a simulation, but are limited in functionality compared
to Win32 UI controls

. Dialog names and Control names must be unique; if
multiple controls of the same name exist, the simulation
will not be able to differentiate between them

. Spaces in dialog names and Control names are treated as
underscores

. Dialog names and Control names are case sensitive
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Supported Win32 Ul Controls

This table identifies all of the Win32 UI Controls available
in Enterprise Architect for user interface design and
simulation.

Access

Ribbon Design > Diagram > Toolbox : £ >
Specify 'User Interface - Win32' in the
'Find Toolbox Item' dialog

Keyboard Ctrl+Shift+3 : 2. > Specify 'User
Shortcuts Interface - Win32' in the 'Find Toolbox
[tem' dialog

Win32 Ul Controls

Control Description
Button Button controls are a common way to

allow user interaction during runtime; for
example, an OK button in a login screen.
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A Button can respond to a click event,
defined by adding an 'OnClick' Tagged
Value.

In response to a click event, a button can
be used to, for example, send a signal,
causing a trigger to fire during runtime.

Customizable design properties:
. Client Edge

. Default Button

. Disabled

. Flat

. Horizontal Alignment

. Modal Frame

. Multiline

. Right Align Text

. Right To Left Reading Order
. Static Edge

. Tabstop

. Transparent

. Vertical Alignment

. Visible

Tagged Values:

. OnClick — specifies a JavaScript
command to be executed in response to
a click event on this Button

Properties:
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. Enable
. Show
. Text

Operations:
. MoveTo

Check Box Customizable design properties:
. Auto
. Client Edge
. Disabled
. Flat
. Horizontal Alignment
. Left Text
. Modal Frame
. Multiline
. Right Align Text
. Right To Left Reading Order
. Static Edge
. Tabstop
. Vertical Alignment
. Visible
Tagged Values:

. OnCheck — specifies a JavaScript
command to be executed in response to
a change 1n the value of this checkbox

Properties:
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. Checker — integer value [0|1]
. Enable

. Show

. Text

Combo Box | Customizable design properties:
. Auto

. Client Edge

. Data — semi-colon delimited string of
values to populate the combo box at
runtime; for example, "yes;no;maybe

. Disabled
. Has Strings

"

. Lowercase

. Modal Frame

. Right Align Text
. Right To Left Reading Order
. Sort

. Static Edge

. Tabstop

. Type

. Uppercase

. Vertical Scroll

. Visible
Operations

. AddString (string)
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. DeleteAll ()

. Deleteltem (number) — delete item at
specified index

. DeleteString (string) — deletes all items
matching string

. GetCount ()

. GetString (number)

. Insertltem (number, string)

. InsertString (number, string)
. SetString (number, string)
Properties:

. Enable

. Selection — index of the currently
selected item

. Show

Dialog Customizable design properties:
. Absolute Align
. Application Window

. Border - Resizing or Dialog Frame
only

. Center

. Client Edge
. Center Mouse
. Clip Siblings
. Disabled
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. Horizontal Scrollbar
. Left Scrollbar

. Local Edit

. Maximize Box

. Minimise Box

. No Activate

. Overlapped Window
. Palette Window

. Right Align Text

. Right To Left Reading Order
. Set Foreground

. System Menu

. System Modal

. Title Bar

. Tool Window

. Topmost

. Transparent

. Vertical Scrollbar

. Visible

. Window Edge
Properties:

. Enable

. Show

. Text

Operations:
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. MoveTo

Edit Control / = Customizable design properties
Rich Edit . Align Text
Control . Auto HScroll
. Auto VScroll
. Border
. Client Edge
. Disabled
. Lowercase (Edit Control only)
. Modal Frame
. Multiline
. Number
. Password
. Read Only
. Right Align Text
. Right To Left Reading Order
. Static Edge
. Tabstop
. Transparent
. Uppercase (Edit Control only)
. Visible
. Want Return
Properties:
. Enable
. Show
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Group Box

List Box
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. Text

Customizable design properties:
. Client Edge

. Disabled

. Flat

. Horizontal Alignment
. Modal Frame

. Right Align Text

. Static Edge

. Tabstop

. Visible

Properties:

. Enable

. Show

. Text

Customizable design properties:
. Border

. Client Edge

. Disable No Scroll

. Disabled

. Left Scrollbar

. Modal Frame

. Right Align Text

. Selection
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List Control
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. Sort

. Static Edge

. Tabstop

. Vertical Scroll

. Visible

Operations:

. AddString (string)

. DeleteAll ()

. Deleteltem (number) — delete item at

specified index

. DeleteString (string) — deletes all items

matching string

. GetCount ()

. GetString (number)

. Insertltem (number, string)

. InsertString (number, string)

. SetString (number, string)
Properties:

. Enable

. Selection — index of the currently

selected 1item

. Show

Customizable design properties:
. Alignment
. Always Show Selection
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. Border

. Client Edge

. Disabled

. Edit Labels

. Left Scrollbar

. Modal Frame

. No Column Header
. No Scroll

. Single Selection
. Sort

. Static Edge

. Tabstop

. View

. Visible

Tagged Values:

. Columns — string to initialize column
names and sizes for this List Control,

separated by semi-colons: for example,
"Column1;100;Column2;150;"

Operations:
. AddString (string)
. DeleteAll ()

. Deleteltem (number) — delete item at
specified index

. DeleteString (string) — deletes all items
matching the string
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. GetCount ()

. GetString (number, number)

. Insertltem (number, string)

. InsertString (number, string)

. SetString (number, number, string)
Properties:

. Enable

. Selection — index of the currently
selected item

. Show
Picture The 1nitial Picture Control image can be
Control set using the Tagged Value 'Image'. Set

the value to a filename accessible by the
simulation. The image can be modified at
runtime using the ChangelmageFile
method in JavaScript. This takes a single

string parameter of the filename to be
loaded.

Set the 'Image Type' property to the
correct type for the file (either Bitmap,
Enhanced Metafile or Icon). This setting
cannot be modified at runtime.

Customizable design properties:
. Border

. Center Image

. Client Edge
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. Color (frame color)
. Disabled

. Image Type

. Modal Frame

. Real Size Image

. Static Edge

. Tabstop

. View

. Visible
Operations:

. ChangelmageFile (string) - filename
Properties:

. Show

Progress Customizable design properties:
Control . Border

. Client Edge
. Disabled

. Marquee

. Modal Frame
. Smooth

. Static Edge
. Tabstop

. Vertical

. Visible
Tagged Values:
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. Range — string specifying minimum
and maximum values for this control,
separated by a semi-colon: for
example, "1;100"

Properties:

. Enable

. Pos

. Range

. Show

. Step

Customizable design properties:
. Auto

. Client Edge

. Disabled

. Flat

. Group

. Horizontal Alignment
. Left Text

. Modal Frame

. Multiline

. Static Edge

. Tabstop

. Vertical Alignment

. Visible

Tagged Values:
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. OnChangeSelection — specifies a
JavaScript command to be executed in
response to a change in selection of this
radio button

Properties:

. Checker — integer value [0|1]
. Enable

. Selection — integer value

. Show

Slider Customizable design properties:
Control . Auto Tick

. Border

. Client Edge

. Disabled

. Enable Selection Range

. Modal Frame

. Orientation

. Point

. Static Edge

. Tabstop

. Tick Marks

. Transparent

. Transparent Background

. Tooltips

. Visible
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Spin Control
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. Range — string specifying minimum

and maximum values for this control,
separated by a semi-colon: for

example, "1;100"

Properties:
. Enable
. PageSize
. Pos

. Range

. Show

. Alignment

. Arrow Keys

. Auto Buddy
. Client Edge

. Disabled

. Modal Frame
. No Thousands
. Orientation

. Set Buddy Integer
. Static Edge

. Tabstop

. Visible

. Wrap

Customizable design properties:
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Static Text /
Label
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. Range — string specifying minimum

and maximum values for this control,
separated by a semi-colon: for

example, "1;100"
Properties:

. Enable

. Pos

. Range

. Show

Customizable design properties:
. Align Text

. Border

. Client Edge

. Disabled

. End Ellipsis

. Modal Frame

. Path Ellipsis

. No Wrap

. Notify

. Path Ellipsis

. Right Align Text
. Simple

. Static Edge

. Sunken
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. Tabstop

. Visible

. Word Ellipsis
Properties:

. Enable

. Show

. Text

Tab Control | Customizable design properties:
. Border
. Bottom
. Buttons
. Client Edge
. Disabled
. Flat Buttons
. Focus
. Hot Track
. Model Frame
. Multiline
. Right Align Text
. Static Edge
. Style
. Tabstop
. Tooltips
. Visible
Tagged Values:
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. Tabs — string specifying names of each
tab for this control, separated by a
semi-colon: for example, "Tab 1;Tab
2;Tab 3;"

Properties:
. Enable
. Show

Tree Control = Customizable design properties:
. Always Show Selection
. Border
. Check Boxes
. Client Edge
. Disable Drag Drop
. Disabled
. Edit Labels
. Full Row Select
. Has Buttons
. Has Lines
. Horizontal Scroll
. Left Scrollbar
. Lines At Root
. Modal Frame
. Right Align Text
. Right To Left Reading Order
. Scroll
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. Single Expand
. Static Edge

. Tabstop

. Tooltips

. Track Select
. Visible
Operations:

. Delete () - delete the specified
Treeltem

. Insertltem (string) - dotted path of the
new tree item to be inserted; any parent
items 1n this dotted path that do not yet
exist will be created automatically

. InsertString (string) - See Insertltem

. Treeltem (string) - dotted path of the
tree item to be accessed; use the Text
property to set text for this tree item, or
use the Delete operation to delete this
item from the tree

Properties:
. Enable

. Selection — string containing dotted
path of the selected tree item

. Show

. Text — get or set text for a specified
Treeltem

Examples:
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dialog.MyDialog.MyTreeControl.Insertlt
em("Root.Parent.Child");

dialog.MyDialog.MyTreeControl. Treelte
m("Root.Parent.Child"). Text =
"Modified";

dialog.MyDialog.MyTreeControl.Selecti
on = "Root.Parent";

dialog.MyDialog.MyTreeControl. Treelte
m("Root.Parent.Modified").Delete();
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Win32 Control Tagged Values

Various properties that can affect the appearance and
behavior of each Win32 dialog and control can be
customized at design time via Tagged Values provided by
the Win32 User Interface profile.

Tagged Values

Some control types support the addition of special Tagged
Values that modify their behavior.

Controls such as Buttons, Check Boxes and Radio Buttons
can react to GUI events and execute a JavaScript command.
To allow a control to respond to an event, create a new
Tagged Value with an appropriate name; for example,
'OnClick’, then type the JavaScript command into the value.

Tab Controls can use a 'Tabs' Tagged Value to define the
tabs that will appear within this control when it is simulated.

Slider Controls, Spin Controls and Progress Controls can
use a 'Range' Tagged Value to define the default minimum
and maximum values accepted by the control during
simulation.

Tag Description

Columns Applies to: List Control

Use: Initializes column names and widths
for a List Control. Each column name and
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OnClick

OnCheck

OnChangeSel

ection

Range

Tabs
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width 1s separated by a semi-colon; for
example, "Column1;100;Column2;150;".

Applies to: Button

Use: Identifies the JavaScript command
to be executed in response to a click
event on a Button control.

Applies to: Check Box

Use: Identifies the JavaScript command
to be executed in response to a change in
the value of a Check Box control.

Applies to: Radio Button

Use: Identifies the JavaScript command
to be executed in response to a change in
the value of a Radio Button control.

Applies to: Slider Control, Spin Control,
Progress Control

Use: Specifies the default minimum and
maximum values for the control,

separated by a semi-colon: for example,
"1;100".

Applies to: Tab Control

Use: Specifies the name of each tab to be
created for the Tab Control, separated by

Page 133 of 148



Dynamic Simulations 2 September, 2021

a semi-colon: for example, "Tab 1;Tab
2;Tab 3;".
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BPMN Simulation

BPMN simulation is a method for visualizing and validating
the behavior of your BPMN Business Process diagrams.
With visual indications of all currently executing activities
and the possible activities that can be executed next, you
will easily be able to identify and resolve potential issues
with the process you have modeled.

Simulating BPMN models is similar to simulating standard
UML Behavioral models, except that BPMN:

. Uses some different element types (such as Gateway
instead of Decision) and

. Operates on scripting placed, generally, in the appropriate
'"Tagged Value' field associated with the connectors and
clements, instead of in the 'Properties' fields (and, if you
prefer, rather than in the 'Execution Analyzer Build
Scripts' dialog); the scripting 1s written in JavaScript

Working with BPMN Simulation

Activity Detail

Create a When you create a BPMN model suitable

BPMN for simulation, you take into

Simulation consideration how you represent the start

Model point, the flow and the conditions to be
tested.
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Compare The simulation of BPMN Business
UML Process models has a number of
Activities to | differences to the simulation of UML
BPMN Activity diagrams.
Processes

Notes

. BPMN simulation is available in the Unified and Ultimate
Editions of Enterprise Architect
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Create a BPMN Simulation Model

As part of the process of developing a simulation model,
consider which of the three options for performing the
simulation you prefer to apply:

. Execute a simulation script to initialize the variables for
the diagram - select 'BPMN' as the Platform, execute the
simulation as 'As Script' and select the script; you would
then define the conditions and decisions as JavaScript
declarations within the Tagged Values of the elements and
connectors on the diagram, either before you start the
simulation or during the simulation

. Do not use a script, but initialize the variables within the
first Activity and, again, modify the conditions and
decisions within the Tagged Values of the elements and
connectors, then execute the simulation as 'Interpreted';
you can then re-initialize the variables during simulation,
as well as the conditions

. Execute the simulation as 'Manual' and manage the flow
and conditions manually at each step

Create a BPMN diagram suitable for
simulation

Ste | Action
p
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1

Create a Business Process or BPEL diagram from
the BPMN 2.0 technology. If you create a BPEL
diagram Enterprise Architect displays specialized
dialogs to streamline the creation of compliant
models.

We recommend that you create a Start Event to
clearly show where your simulation starts. You have
several choices for the Event Type; the choice does
not influence the simulation of your model. If no
Start Events are defined, the simulation will start
from an Activity that has no incoming Sequence
Flows.

Add all of the Activities that are involved in the
Process being modeled. You have several choices for
the Task Type; the choice does not influence the
simulation of your model. The behavior of Activities
can be further decomposed by specifying an Activity
Type of Sub-Process and selecting Embedded or
CallActivity. Standard Loops are also supported.

Add Sequence Flows between your activities. In the
'BPEL properties' dialog you can enter the condition
that must be satisfied (True) before the Sequence
Flow will be followed. You can also set the
conditionType to 'Default’ to ensure that this flow
will be taken if all other branches fail the condition
specified.
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If you are not working with a BPEL diagram, you
use the conditionExpression and conditionType
Tagged Values.

5 | Add End Events for any conditions that will cause
the process or active execution path to end. You
have several choices for the Event Type; of these
only the Terminate type will influence the execution.
In simulations with multiple active nodes, it causes
the entire process to terminate instead of just the
thread that reaches that node.

Notes

. To include Activities that are in Packages external to the
Package being simulated, either draw a:
- Package Import connector from the Package
containing the diagram
being simulated to each external Package, or
- Dependency connector from the Package containing
the diagram
being simulated to each Activity in the external
Packages
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Initialize Variables and Conditions

For a BPMN simulation model, you can initialize your
variables in an Execution Analyzer script. You can also
initialize these variables in the Tagged Values of the first
Activity element of the process, which gives you greater
flexibility in adding and changing variables as the
simulation proceeds. Similarly, you can define the
conditions and values to apply at the various decision points
(Gateways) in the process, in the Tagged Values of the
Sequence Flow connectors.

If you want to incorporate a user-interface into your
simulation process, using Win32, you again use Tagged
Values to identify the dialog or prompt to display, in the
Activity element just prior to the point at which the value or
decision 1s processed.

For the simulation of UML diagrams, variables inside the
'sim' object and 'this' object are displayed in the Local
Variables window.

Access

Display the '"Tags' tab of the Properties window, using one
of the methods outlined here.

Ribbon Explore > Portals > Windows >
Properties > Properties > Tags
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Keyboard Ctrl+2 > 'Tags' tab of the Properties
Shortcuts window

Initialize Variables

1. On the diagram, click on the first Activity element in the
process.

2. In the 'Tags' tab of the Properties window, click on the
drop-down arrow of the taskType 'value' field, and select

'Script'.
3. In the script 'value' field, type in the appropriate
JavaScript code, such as:

sim.loan=true; sim.status="undefined';

Define Conditions

1. On the diagram, click on a Sequence Flow connector that
issues from a Gateway element.

2. In the 'Tags' tab of the Properties window, click on the
drop-down arrow of the conditionType 'Value' field, and
select 'Expression'.

3. In the conditionExpression 'Value' field (<memo>*) click
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on the [~/ button to display the Tagged Value Note
window. Type in the appropriate JavaScript code, such as:
sim.status=="Hold"

4. Click on the OK button. The statement text displays as a
label of the connector.

Incorporate Win32 User Interface

1. On the diagram, click on the Activity element that
represents where the decision 1s made.

2. In the 'Tags' tab of the Properties window, click on the
drop-down arrow of the 'taskType value' field, and select
'Script'.

3. In the 'script value' field, type in the appropriate
JavaScript code, such as:

dialog.Screenl.Show=True;
(This statement displays the dialog Screenl. You can
temporarily hide the dialog by changing 'Show' to False.)
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Comparison of UML Activities and
BPMN Processes

The execution and simulation of BPMN models have a
number of differences from the execution and simulation of
UML Activity diagrams. The mapping of similar concepts,
and the differences between the two methods of expressing
the behavior of a system, are presented here.

Comparison of UML Activities and BPMN
Processes

UML Activity BPMN Business Process

The starting | The starting point is defined by a Start
point 1s Event. This implies a specific cause for
defined by an  the Activity to start, although it could be
Initial Node. | unspecified.

No method of

specifying

why the

Activity was

started 1s

available.

The basic The basic behavior unit in an Activity is
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behavior unit
in an Activity
1s the Action
element.
UML
provides
many
different
forms of
Actions,
although the
simulation
makes use of
a small
subset of
these.

A Control
Flow 1s used
to connect
the elements
on an
Activity
diagram. A
distinguishin
g feature is
that only a
single
Control Flow
can be
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the Activity element. A number of
different Task Types are available. These
typically describe different methods of
execution (for example Manual) as
opposed to what happens.

A Sequence Flow is used to connect the
clements on a Business Process diagram.
These differ from UML Activity
diagrams 1n that all valid sequence flows
are taken by default. To restrict flow on a
Sequence Flow set the conditionType
Tagged Value to 'Expression' and create
the script in the conditionExpression
Tagged Value.
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followed
from any
node, except
for an
explicit Fork
Node. To
restrict flow

on a Control
Flow, add a
Guard.

A Decision A Gateway node set to 'Exclusive’ 1s used
node isused = when a single path must be selected. It is
to explicitly | also used to combine the potential flows
model a again. A direction can be specified as
decision 'Converging' or 'Diverging' to explicitly
being made. | select between the two modes.

A Merge

node, which

uses the same

syntax 1s

used when

the potential

flows are

combined

back into

one.

A Forknode = A Gateway node set to 'Parallel’ 1s used to
1s used to explicitly model concurrent execution of
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concurrently | multiple nodes. It 1s also used to wait for

execute all incoming flows to become available
multiple and leave with a single flow. A direction
nodes, while  can be specified as 'Converging' or

a Joinnode, @ 'Diverging' to explicitly select between
using the the two modes.

same syntax

1s used to

wait for all

Incoming

flows to

become

available and
leave with a
single flow.

There 1s no A Gateway node set to Inclusive 1s used
allowance for | to explicitly model the situation where all
concurrently = outgoing flows with a true condition are
executing executed concurrently.

only some

outputs from

a node for

UML

Activities. If

you needed

this you add

later Control

Flows with

the
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appropriate

Guards.

A Call Activity elements are set as a

Behavior CallActivity Sub-Process when behavior
Action 1s needs to be further decomposed by

used when referring to an external activity.
behavior

needs to be

further

decomposed

by referring

to an external

activity.

Activity Activity elements are set as an Embedded
Action Call Sub-Process when behavior needs to be
Behavior further decomposed without referring to
Action. an external activity.
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